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2. Abbreviations 
 
BCG  Bacille-Calmette Guerin vaccine 
 
DE  Design Effect 
 
DTP   Diphtheria–Tetanus–Pertussis (vaccine) 
 
HepB   Hepatitis B (vaccine) 
 
Hib   Haemophilus influenzae type b (vaccine) 
 
MCV  Measles - Containing Vaccine 
 
OPV   Oral Polio Vaccine 
 
PPS   Probability Proportional to Size (sampling) 
 
PSUs   Primary Sampling Units 
 
SIA   Supplemental Immunization Activity 
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3. Glossary 

 
By Card  A dose is by card if its date is complete. This means that 

immunization dates are read from the immunization card. 
 

By History  A dose is by history if the date of immunization on the 
immunization card is incomplete or absent, but history of 
immunization is reported by parents. 

 
Confidence level A level of confidence set in computing confidence limits. A 

level of 95% (or 0.95) is conventionally used but can be set 
higher or lower. A level of confidence of 95% implies that 19 
out of 20 times the results from a survey using these methods 
will capture the true population value. 

 
Confidence limits or 
Confidence Intervals  

 The upper and lower limits of the confidence interval in interval 
 estimation. The interval itself is called the confidence interval 
 or confidence range. Confidence limits are so called because 
 they are determined in accordance with a specified or 
 conventional level of confidence or probability that these limits 
 will in fact include the population parameter being estimated. 
 Thus, 95% confidence limits are values between which we are 
 95% confident that the population parameter being estimated 
 will lie. Confidence limits are often derived from the standard 
 error 

 
 
Fully immunized child (FIC) Usually, this is a child who has received doses of the 

“standard eight” antigens – BCG, DTP (3 doses), polio (3 
doses), and measles vaccines. In countries at risk for yellow 
fever, this should be included. New vaccines (hepatitis B, and 
Hib) are not usually included in this definition; in some 
countries, BCG is excluded from this definition. The definition 
of FIC used in a survey should be specified and it may vary 
according to the national immunization policy 

 
  Fully immunized child (FIC) 
  by 1 year of age  

 A child is considered as fully vaccinated by 1 year of age if 
 s/he has received all recommended dose according to the 
 national immunization policy by 1 year of age, and each 
 administered dose was valid. 

 
Minimum age and minimum 
interval 

 

The minimum age and intervals are used to determine if a dose
 is valid (i.e. physiologically efficacious) 

Valid doses: Doses that were administered when the child had reached the 
minimum age for the vaccine, and were administered with the 
proper spacing between doses according to the national 
schedule. 
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4. Introduction 
 

Immunization coverage is a crucial indicator of national immunization services and of the health 
system in general. In most countries, immunization coverage refers to the proportion of the target 
population that is immunized.  
 

In addition to routine monitoring immunization coverage by the administrative method, an 
immunization coverage survey may be conducted to: (1) provide additional information about 
immunization coverage, (2) help verify the accuracy of the administrative coverage estimates, (3) 
assess the output and performance of the immunization system, and (4) identify areas of weak 
performance and/or high risk so that focused actions can be taken. 
 
4.1 Immunization Coverage Survey 
An immunization coverage survey involves a representative sample of individuals to determine 
their immunization status. It includes visiting homes and collecting information by either verbal 
history or immunization cards. The results can then be generalized to the entire population from 
where the sample was selected.  
 

One of the survey methods, commonly used to assess immunization coverage, is the cluster 
sampling method based on probability proportional to population size.  
 

The technical basis to use the method and field guide on how to implement the immunization 
coverage cluster survey is described in the WHO "Immunization Coverage Cluster Survey" 
manual. 
 
5. The excel workbook  
 

An immunization Coverage Cluster Survey implies a considerable amount of data to be 
computed in order to obtain reliable results. 
 

The Excel workbook template was designed to electronically support and assist field 
investigators during an immunization coverage cluster survey, and it enables them to perform the 
following tasks: 

a. adapt the workbook to your survey, in terms of variables and analysis included in the 
survey 

b. perform data entry or accept (at certain conditions) imported databases 
c. analyse data 
d. estimate proportions with 95% Confidence Intervals of each surveyed variable  
e. put the results of the survey in graphics 

 
6. Description of the excel workbook 
 

In the excel workbook there are a total of 27 worksheets, grouped as follows (see in annex 1 for 
detailed information on each worksheet): 
 
Worksheet 1-3:  
 

They summarize the content of the workbook and provide general instructions on how to use the 
workbook. They also contain general information on the survey which have to be manually 
entered (i.e. overall parameters, National Immunization Schedule, etc). they are as follows: 
 

• Readme 
• Overall parameters 
• Immunization schedule 
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Worksheet 4:  
 

• Raw data entry sheet 
It is the master data entry file. For further instruction on data entry options see paragraph 7 of 
this users' guide. 
 
Worksheets 5-6: generic analysis worksheets 
 

Data entry is not allowed, to prevent any mistakes in the formulas. Columns may be erased and 
added according to the survey (see "how to add a column/worksheet" later in this guide).  
They are as follows: 

• No entry!!! Derived variables 
• Cluster summary analysis 

 
Worksheet 7-27: specific analysis worksheets  
 

Data entry is NOT expected in these worksheets, and calculation will be performed automatically. 
However, should you wish to do enter manually the data, in chapter 9 of this users' guide you find 
instructions on how to do data entry and information on denominators and numerators used for 
the calculations in each sheet. 
 

Cells in each worksheet contain formulas to calculate the estimated proportion of the variable 
under study (with 95% Confidence Intervals, CI) 
 

They are as follows: 
• % Immunization Cards 
• BCG - any (by either history or card) 
• BCG - card 
• DTP1-any (by either history or card) 
• DTP1 - card 
• DTP3 - any (by either history or card) 
• DTP3 - card 
• Drop-out DTP1-DTP3 
• MCV (routine) - any (by either history or card) 
• MCV (routine) - card 
• SIA (MCV) - any (by either history or card) 
• SIA (MCV) - card 
• Fully immunized - any (by either history or card) 
• Fully immunized card  
• Fully immunized - valid  
• Fully immunized by 1 year of age 
• Fully immunized by 1 year of age valid 
• Fully immunized boys 
• Ex place/time unknown 
• Data set for the graph 
• Ex of a graph 
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7. Preliminary steps before using the excel workbook 
 

Make a copy of the excel workbook by changing its name, as follows: 
 

1. Open the excel workbook 
2. On the File menu, click Save As.  
3. In the File name box, type a new name for the workbook. 
4. Click Save 
 
By doing so, you have saved the original copy of the master worksheet in your PC, and can 
freely use the copy for the survey. 
 
8. Adaptation of the excel workbook to the current survey 
 

The excel workbook provided is a model and may be changed according to the objectives of the 
survey.  
In the copy you have just created you may either remove or add worksheets and/or columns to 
adapt the workbook to your own needs: 

8.1 To remove a worksheet from the copy of the template 
8.1.1 Open the "RAW DATA ENTRY" sheet 
8.1.2 Delete columns that are not of your interest as follows: 

8.1.2.1 Select the column you want to delete 
8.1.2.2 On the Edit menu, click Delete 

8.2 Insert any possible column that may be of interest in the survey as follows: 
8.2.1 Open the "RAW DATA ENTRY" sheet 
8.2.2 Insert a single column Click a cell in the column immediately to the right of 

where you want to insert the new column. For example, to insert a new column 
to the left of column B, click a cell in column B, left-click on the top of the 
column, and click Insert in the Edit menu 

8.2.3 In the Insert menu, click Columns 
 

Important: if you add columns to the master file, make sure that formulas in the other 
worksheets are linked and correct, as they will influence the final results. 
 

8.3 If you have deleted columns in the sheet, make sure that you have deleted also the 
linked analysis sheet. 

 

Example: if in your survey, you are NOT interested in the MCV (SIA) immunization, then: 
a. Open the "RAW DATA ENTRY" sheet 
b. Delete columns related to the MCV (SIA) data (i.e. AC, AD, AE, in the master file), 

as explained above 
c. Delete worksheets related to the MCV (SIA) analysis (i.e. worksheet number 17, 18), as 

follows: 

a) Select the sheets you want to delete, as follows: 
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When you enter or change data, the changes affect all selected sheets. These changes may 
replace data on the active sheet and other selected sheets. 

To select Do this 

A single sheet Click the sheet tab.  

 
If you don't see the tab you want, click the tab scrolling buttons to 
display the tab, and then click the tab. 

 

Two or more adjacent 
sheets 

Click the tab for the first sheet, and then hold down SHIFT and click 
the tab for the last sheet. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet, and then hold down CTRL and click the 
tabs for the other sheets. 

All sheets in a 
workbook 

Right-click a sheet tab, and then click Select All Sheets on the 
shortcut menu (shortcut menu: A menu that shows a list of commands 
relevant to a particular item. To display a shortcut menu, right-click an 
item or press SHIFT+F10.). 

Note: If sheet tabs have been colour-coded, the sheet tab name will be underlined in a user-
specified colour when selected. If the sheet tab is displayed with a background colour, the sheet 
has not been selected. 

b) On the Edit menu, click Delete Sheet. 

To modify then the graph accordingly, proceed as follows: 

d. Open worksheet 26 and Delete rows related to the MCV (SIA) data (i.e. 15, 16) 
 

8.4 On the worksheet "6. CLUSTER ANALYSIS SUMMARY", you must press the pink 
button after you imported your data1. 

8.5 In the generic analysis worksheet “No entry!!! Derived variables”, you will have to 
look through the formulas and make sure that the definitions are what you want 
them to be. Pay special attention to valid and invalid doses and number of days put 
in the formulas. 

8.6 Depending on the size of the database you import, you may have to copy the last 
row several times on these two sheets: 
5.NO ENTRY!!! DERIVED VARIABLES 
6. CLUSTER ANALYSIS SUMMARY 

                                                 
1 Note that you must have ENABLED MACROS when you opened the file.  If the macro is not enabled - often 
you can tell because the button will have small white dots showing at the corners - then go to Tools ->Macros -
> Security  and turn security to level MEDIUM.     Then close all open excel files, and re-open them, enabling 
macros.     
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The workbook is geared towards assuming that you have (maximum) 2500 subjects, 
and no more than 250 clusters in total (and no more than 20 strata).  If there are 
more, you will need to copy the last row in the relevant worksheets, and duplicated 
the correct number of times (using copy-paste, to ensure that formulas and not 
values are copied).   
Make sure to check this before reading results in the specific analysis worksheets. 

8.7 Then comes the adaptation of the specific analysis worksheets. If you want a 
weighted mean of different strata you have to add the weight in column A in front of 
each stratum. This has to be done in all the specific worksheets. Once you have 
imported the data you want to analyse, you should push the green and blue button 
at the top of the first specific worksheet “7. % IMMUNIZATIONCARDS “. 

 
 

9. Data entry 
 

Once your worksheet has been adapted you may start the data entry. There are two possible 
options for doing data entry: 
 

a. enter manually the raw data in the "RAW DATA ENTRY" sheet 
 

b. enter manually the data using other software programs (i.e., Epi-Info, Epi Data, etc), 
and then export them to excel for analysis. 

 
9.1. Data entry of the immunization coverage survey in the excel worksheet: 

 

1- Open the "RAW DATA ENTRY " sheet in the excel workbook. 
2- Enter you data manually 
3- At the end of data entry you can see the results in the other excel sheets accordingly. 
 

As you may see, in each cells of the "RAW DATA ENTRY" sheet the right up corner is red, and it 
contains a comment/suggestion of the Survey Guru to help you in the data entry. Put your cursor 
on the cell and the comment will be shown. 
 
9.1.1. Data entry of dates 
 

When you have to enter dates (i.e. date of birth, immunization dates) in the data base, make 
sure the computer is set on the right date system. 
 

In the template excel workbook, dates are set to be entered as 10 digits entry: dd/mm/yyyy. 
 

Follow the following steps to set the computer to this system: 
 

1- On the Microsoft Windows Start menu, point to Settings 
2- Click Control Panel 
3- Double click the Regional Settings or Regional Options icon 
4- In the Short date format list, click a format that uses four digits for the year ("yyyy") 
5- Choose " / " as Date separator 
 

NOTE: for further information on dates data entry, see the Microsoft excel help (F1). 
 
9.1.2 Data entry, number of digits and legal values 
 

As follows you find the list of original variable (in the yellow cells) in the "raw data entry" sheet: 
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• ID 
Numeric  
Identification number of the surveyed child. It is the number of the form/questionnaire used 
for the survey 
 

• State 
Numeric  
Geographical location of the child. To be either modify or removed accordingly. 
 

• Township 
Numeric  
Geographical location of the child. To be either modify or removed accordingly. 
 

• Rural Health Centre 
Numeric  
Geographical location of the child. To be either modify or removed accordingly. 
 

• Village 
Numeric  
Geographical location of the child. To be either modify or removed accordingly. 
 

• Cluster number 
Numeric. The range will depend on the number of cluster in your survey (see the 
"Immunization Coverage Cluster Survey" manual for more details. 
Cluster number of the surveyed child. To be either modify or removed accordingly. 
 

• Child number 
Numeric. The range will depend on the number of children in each cluster (see the 
"Immunization Coverage Cluster Survey" manual for more details. 
Child number within his/her cluster 
 
• Date of birth of the child 
10 digits  
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• Sex (gender of the child) 
1 digit, numeric field 
Legal value  1 = Male 

2 = Female 
 

• IMMUNIZATION Card 
1 digit, numeric field 
Legal value  1 = Yes (child with immunization card) 

2 = No (child with no immunization card) 
 

• SIA (MCV) Supplementary Immunization Activity (SIA) for MCV 
1 = Yes 
2 = No 
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• Date (in the immunization card) 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No  (child not immunized) 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• VIT A  
1 digit, numeric field 
Legal value : 1 (Yes) 

2 (No) 
3 do not know 
 

• BCG: immunization status 
 

1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No  (child not immunized) 
 

• BCG Date (date of the BCG immunization written in the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• OPV1 immunization status  
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• OPV1 Date (date of the OPV1 immunization written in the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• DTP1 immunization status 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• DTP1 Date (date of the DTP1 immunization written in the card) 
10 digits date field 
Date format : dd/mm/yyyy 
$ 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• MCV immunization status 
1 digit, numeric field 
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Legal value : 1 = Yes (child immunized and with immunization card) 
2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• MCV Date (date of the MCV vaccination written on the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• OPV2 Immunization status 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• OPV2 Date (date of the OPV2 vaccination written on the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• DTP2 immunization status 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• DTP2 Date (date of the DTP2 vaccination written on the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• OPV3 immunization status 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• OPV3 Date (date of the OPV3 vaccination written on the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• DTP3 immunization status 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 
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• DTP3 Date (date of the DTP3 vaccination written on the card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• SIA (MCV) immunization status 
1 digit, numeric field 
Legal value : 1 = Yes (child immunized and with immunization card) 

2 = Yes (child with history of immunization only) 
3 = No   (child NOT immunized) 

 

• SIA (MCV) Date (date of the SIA, written on the SIA card) 
10 digits date field 
Date format : dd/mm/yyyy 
 

Important: read instructions on how to set your system dates on the users' guide (see 
chapter 9.1.1.)!!! 
 

• Adverse Events Following Immunization (AEFI) (high fever) 
1 digit, numeric field 
Legal value : 1 = Yes  

0 = No  
 

• Adverse Events Following Immunization (AEFI) (vomiting) 
1 digit, numeric field 
Legal value : 1 = Yes  

0 = No  
 

• Adverse Events Following Immunization (AEFI) (abscess) 
1 digit, numeric field 
Legal value : 1 = Yes  

0 = No  
 

• Adverse Events Following Immunization (AEFI) (severe pain) 
1 digit, numeric field 
Legal value : 1 = Yes  

0 = No  
 

• Adverse Events Following Immunization (AEFI) (rash) 
1 digit, numeric field 
Legal value : 1 = Yes  

0 = No  
 

• Adverse Events Following Immunization (AEFI) (not immunized) 
1 digit, numeric field 
Legal value : 1 = Yes  

0 = No  
 

• Adverse Event Following Immunization (AEFI) and reporting 
1 digit, numeric field 
Legal value : 1 = No adverse event 

2 = Yes adverse event reported 
3 = Yes adverse event BUT NOT reported 
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4 = Unknown 
 
 

• Reasons for Failure to Immunize Y/N 
1 digit, numeric field 
Legal value : 1 = No 

2 = Yes 
 

• Reasons for Failure to Immunize (type) 
 

1 digit, numeric field 
Legal value : 1 = unaware of need for immunization 

2 = unaware to return for 2nd and 3rd dose 
3 = place/time of immunization unknown  
4 = fear for side reactions 
5 = wrong ideas about contraindications  
6 = postponed  
7 = no trust in immunization  

    8 = rumours  
9 = place of immunization too far  
10 = time of immunization inconvenient  
11 = vaccinator absent  
12 = vaccine not available 
13 = mother too busy 
14 = family problems 

    15 = child ill, not brought 
16 = child ill not immunized 

    17 = child ill 
18 = long waiting time 

    19 = on trip obstacles 
20 = did not know the date of the campaign 

    21 = not free at the time 
    22 = religious reasons 

23 = lack of information (general) 
24 = forgot the child’s age 

 
9.2 Data entry using a different software 
 

When you enter data entry using other software programs (i.e., Epi-Info, Epi Data, etc), there are 
few conditions that need to be respected: 
 
9.2.1 Organize the data entry mask making sure that variables have the same name and the 

length, and they are put in the same sequence as in the master file ("RAW DATA 
ENTRY" sheet). 

9.2.2 Dates have the same format as in the master file (for more info on dates setting see 
paragraph 9.1 of this users' guide) 

9.2.3 At the end of the data entry, data should be stored in DBASE format and export to excel. 
As follows you find two possible examples: 
9.2.3.1 How to export the database if data entry was performed with Epi-Info 6.  

   Proceed as follows: 
a. On the Programs menu click Export files 
b. Input file name and click on dBASE4 
c. Write an Output file name 
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d. Click on OK 
 

 
9.2.3.2 How to export the database if data entry was performed with Epi Data 2.1 b 

a. Click on the icon Export Data of the main Epi Data mask, as shown in the 
picture: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. Click on Excel in the Edit menu.  
 

The software will ask you whether you want to export all your variables or select a sub-
setting of variables you want to export. Select the option accordingly. 
 

c. Save the newly created excel file.  
 
Regardless the software you worked on for the data entry, you have now an excel file with the 
survey data in it. 
 

The database has been successfully exported, and it can be now opened with the Excel 
worksheet for analysis, as follows: 

a. Open Microsoft excel 
b. On the File menu click Open 
c. Select your file 
d. Click on Open 

 

You have now to copy your set of data in the copy of the excel master file that you have created 
previously. Proceed as follows: 

a. Select the whole sheet (Left-click on the right top corner of the excel sheet) 
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b. Right-click on the sheet and click on Copy on the Edit menu 
c. Open the "RAW DATA ENTRY" sheet of the excel workbook copy 
d. Right-click on the sheet and click on Paste Special on the Edit menu 
e. Click on Values in the Edit menu 

 

Data have been successfully copied on the excel "RAW DATA ENTRY" worksheet and analysis 
is automatically performed. 
Remember: On the worksheet "6. CLUSTER ANALYSIS SUMMARY", you must press the pink 
button after you imported your data, and the green and blue button at the top of the first specific 
worksheet called “7. % IMMUNIZATIONCARDS”. 
 
Important: if you are working in a French environment, remember that the Epi-Info 6 data entry 
mask will NOT show accented vowels properly. You may wish to use another software instead 
for the data entry (i.e. Epi Data, excel). This is particularly important if data entry is performed by 
clerical support not necessarily familiar with the questionnaire survey and the survey objectives. 
 
10. Data analysis 
 

Once data have been copied in the Excel workbook data analysis is performed automatically by 
excel according to the formulas already present in the excel workbook template. 
 

However, you may wish to do the data entry manually in these sheets, and as follows you find 
information on numerators and denominators on the calculations in worksheet 7-27. 
 

Cells in each worksheet contain formulas to calculate the estimated proportion of the variable 
under study (with 95% Confidence Intervals, CI) 
Detailed instructions on the computations are as follows: 
 
7 % Immunization Cards 
It calculates the estimated proportion (with 95% CI) of children with immunization card.  
 

Numerator (E19:E138): number of children with routine immunization card  
Denominator (D19:D138): number of children sampled in the cluster 
 
 

8 BCG - any (by either history or card) 
 

It calculates the estimated proportion (with 95% CI) of children with BCG immunization by either 
history or card.  
 

Numerator (E19:E138): number of children with BCG immunization by either history or 
card  

Denominator (D19:D138): number of children sampled in the cluster 
 
 

9 BCG - card 
 

It calculates the estimated proportion (with 95% CI) of children with BCG immunization card 
 

Numerator (E19:E138): number of children with BCG immunization by card  
Denominator (D19:D138): number of children sampled in the cluster 
 
 

10 DTP1 - any (by either history or card) 
 

It calculates the estimated proportion (with 95% CI) of children with DTP1 immunization by either 
history or card. 

 

Numerator (E19:E138): number of children with DTP1 immunization by either history 
or card 

Denominator (D19:D138): number of children sampled in the cluster 
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11 DTP1 - card 
 

It calculates the estimated proportion (with 95% CI) of children with DTP1 immunization by card. 
 

Numerator (E19:E138): number of children with DTP1 immunization by card  
Denominator (D19:D138): number of children sampled in the cluster 
 
 

12 DTP3 - any (by either history or card) 
 

It calculates the estimated proportion (with 95% CI) of children with DTP3 immunization by either 
history or card. 
 

Numerator (E19:E138): number of children with DTP3 immunization by either history 
or card 

Denominator (E19:E138): number of children sampled in the cluster 
 

 
13 DTP3 - card 
 

It calculates the estimated proportion (with 95% CI) of children with DTP3 immunization by card. 
 

Numerator (E19:E138): number of children with DTP3 immunization by card  
Denominator (D19:D138): number of children sampled in the cluster 
 
 

14 Drop-out DTP1-DTP3 
 

It calculates the estimated proportion (with 95% CI) of those children who received DTP1 but 
NOT any DTP3. 
 

Numerator (E19:E138): number of children who received DTP1 BUT NOT DTP3 by 
either history or card  

Denominator (D19:D138): number of children who received DTP1 
 
 
15 MCV (routine) - any (by either history or card) 
 

It calculates the estimated proportion (with 95% CI) of children with MCV (routine) immunization 
by either history or card. 
 

Numerator (E19:E138): number of children with MCV (routine) immunization by either 
history or card  

Denominator (D19:D138): number of children sampled in the cluster 
 
 

16 MCV (routine) - card 
 

It calculates the estimated proportion (with 95% CI) of children with MCV (routine) immunization 
by card. 
 

Numerator (E19:E138): number of children with MCV (routine) immunization by card  
Denominator (D19:D138): number of children sampled in the cluster 

 
 
17 SIA (MCV) - any (by either history or card) 
 

It calculates the estimated proportion (with 95% CI) of children with a SIA (MCV) immunization by 
either history of card. 
 

Numerator (E19:E138): number of children with SIA (MCV) immunization by either 
history or card  

Denominator (D19:D138): number of children sampled in the cluster 
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18 SIA (MCV) - card 
 

It calculates the estimated proportion (with 95% CI) of children with MCV (SIA) immunization by 
card. 
 

Numerator (E19:E138): number of children sampled in the cluster 
Denominator (D19:D138): number of children with SIA (MCV) immunization by card  
 
 

19 Fully immunized - any (by either history or card) 
 

It calculates the estimated proportion (with 95% CI) of children fully immunized by either history 
or card per each immunization included in the definition (see the glossary in this users' guide). 
 

Numerator (E19:E138): number of children fully immunized by either history or card  
Denominator (D19:D138): number of children sampled in the cluster 
 
 

20 Fully immunized card  
 

It calculates the estimated proportion (with 95% CI) of children fully immunized by card for each 
immunization included in the definition (see the glossary in this users' guide). 
 

Numerator (E19:E138): number of children fully immunized by card  
Denominator (D19:D138): number of children sampled in the cluster 
 
 

21 Fully immunized - valid  
 

It calculates the estimated proportion (with 95% CI) of fully immunized children with valid doses 
per each immunization included in the definition (see the glossary in this users' guide). 

 

Numerator (E19:E138): number of children fully immunized by card with valid doses  
Denominator (D19:D138): number of children with immunization card sampled in the 

cluster 
 
 

22 Fully immunized by 1 year of age 
 

It calculates the estimated proportion (with 95% CI) of children who were fully immunized by the 
1 year of age (see the glossary in this users' guide). 
 

Numerator (E19:E138): number of children fully immunized by 1 year of age  
Denominator (D19:D138): number of children with immunization card among those 

sampled in the cluster 
 
 
23 Fully immunized by 1 year of age valid 
 

It calculates the estimated proportion (with 95% CI) of children who were immunized with valid 
doses by their 1 year of age. 
 

Numerator (E19:E138): number of children fully immunized by 1 year of age with valid 
doses 

Denominator (D19:D138): number of children with immunization card among those 
sampled in the cluster  

 
 
24 Fully immunized boys 
 

It calculates the estimated proportion (with 95% CI) of boys fully immunized according to the 
definition (see the glossary in this users' guide). 
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Numerator (E19:E138): number of fully immunized boys 
Denominator (D19:D138): number of children with immunization card among those 

sampled in the cluster  
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25 Ex place/time unknown 
 

Example of reason for failure to immunize: calculation of the estimated proportion (with 95% CI) 
of "place/time unknown". 
 

Numerator (E19:E138): number of respondents who did not know place/time of 
immunization 

Denominator (D19:D138): number of respondents for failure to immunize 
 
 

26 Data set for the graph 
 

It is an example of how to group, and arrange data for graphic representation of the estimated 
proportions with 95% CI. 

 
 

27 Ex of a graph 
 

It contains an example of a graph created from the data in the previous worksheet.  
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Annex 1 List of worksheet contained in the excel workbook 
 

Worksheet 
number 

Name Role  

1 README summarizes the content of the workbook, and 
gives indication on how to use it. 

2 OVERALL PARAMETERS is supposed to contain the general parameters 
of the survey. Data entry is expected. 

3 IMMUNIZATION SCHEDULE contains an example of National Immunization 
Schedule of the country as a reference. Data 
entry is expected.  

4 RAW DATA ENTRY SHEET It is the master file. In this sheet data entry of 
the raw data is expected.  
 
Data entry is not allowed, to prevent any 
mistakes in the formulas. Columns may be 
erased and added according to the survey (see 
"how to add a column/worksheet" later in this 
guide) 

5 NO ENTRY!!! DERIVED 
VARIABLES 

It contains a number of derived variables 
generated by excel according to the formulas in 
the various cells. Cells are locked, to prevent 
involuntary mistakes. No data entry is expected. 
For further details on the calculations see annex 
3 

6 CLUSTER SUMMARY ANALYSIS It contains the same variables as in the previous 
worksheet, and it performs the same calculation 
as in the previous worksheet but computed by 
cluster. No data entry is expected. 

7 % Immunization Cards It calculates the estimated proportion (with 95% 
CI) of children with immunization card. 

8 BCG - any  

(by either history or card) 

It calculates the estimated proportion (with 95% 
CI) of children with BCG immunization by either 
history or card. 

9 BCG – card It calculates the estimated proportion (with 95% 
CI) of children with BCG immunization card 

10 DTP1-any (by either history or 
card) 

It calculates the estimated proportion (with 95% 
CI) of children with DTP1 immunization by either 
history or card. 

11 DTP1 – card It calculates the estimated proportion (with 95% 
CI) of children with DTP1 immunization by card. 

12 DTP3 - any (by either history or 
card) 

It calculates the estimated proportion (with 95% 
CI) of children with DTP3 immunization by either 
history or card. 

13 DTP3 – card It calculates the estimated proportion (with 95% 
CI) of children with DTP3 immunization by card. 

14 Drop-out DTP1-DTP3 
It calculates the estimated proportion (with 95% 
CI) of those children who received DTP1 but 
NOT any DTP3. 

15 MCV (routine) - any (by either 
history or card) 

It calculates the estimated proportion (with 95% 
CI) of children with MCV (routine) immunization 
by either history or card 
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16 MCV (routine) - card 
It calculates the estimated proportion (with 95% 
CI) of children with MCV (routine) immunization 
by card. 

17 SIA (MCV) - any (by either 
history or card) 

It calculates the estimated proportion (with 95% 
CI) of children with a SIA (MCV) immunization 
by either history of card. 

18 SIA (MCV) – card 
It calculates the estimated proportion (with 95% 
CI) of children with MCV (SIA) immunization by 
card. 

19 Fully immunized - any (by either 
history or card) 

It calculates the estimated proportion (with 95% 
CI) of children fully immunized by either history 
or card per each immunization included in the 
definition (see the glossary in this users' guide) 

20 Fully immunized card 
It calculates the estimated proportion (with 95% 
CI) of children fully immunized by card for each 
immunization included in the definition (see the 
glossary in this users' guide) 

21 Fully immunized - valid 
It calculates the estimated proportion (with 95% 
CI) of fully immunized children with valid doses 
per each immunization included in the definition 
(see the glossary in this users' guide) 

22 Fully immunized by 1 year of age 
It calculates the estimated proportion (with 95% 
CI) of children who were fully immunized by the 
1 year of age (see the glossary in this users' 
guide) 

23 Fully immunized by 1 year of age 
valid 

It calculates the estimated proportion (with 95% 
CI) of children who were immunized with valid 
doses by their 1 year of age. 

24 Fully immunized boys 
It calculates the estimated proportion (with 95% 
CI) of boys fully immunized according to the 
definition (see the glossary in this users' guide) 

25 Ex place/time unknown 
Example of reason for failure to immunize: 
calculation of the estimated proportion (with 
95% CI) of "place/time unknown" 

26 Data set for the graph 
It is an example of how to group, and arrange 
data for graphic representation of the estimated 
proportions with 95% CI. 

27 Ex of a graph It contains an example of a graph created from 
the data in the previous worksheet. 
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Annex 2 List of original variables 

 
The following original variables (pale blue) may be entered manually either in the "RAW DATA 
ENTRY" sheet, or in another software (see chapter 7 "Data entry" of this users' guide) 
 

• ID 
• State 
• Township 
• Rural Health Centre 
• Village 
• Cluster number 
• Child number 
• Date of birth of the child 
• Sex (gender of the child) 
• IMMUNIZATION Card 
• SIA (MCV) Supplementary Immunization Activity (SIA) for MCV 
• Date (in the immunization card) 
• VIT A 
• BCG: immunization status 
• BCG Date (date of the BCG immunization written in the card) 
• OPV1 immunization status  
• OPV1 Date (date of the OPV1 immunization written in the card) 
• DTP1 immunization status 
• DTP1 Date (date of the DTP1 immunization written in the card) 
• MCV immunization status 
• MCV Date (date of the MCV vaccination written on the card) 
• OPV2 Immunization status 
• OPV2 Date (date of the OPV2 vaccination written on the card) 
• DTP2 immunization status 
• DTP2 Date (date of the DTP2 vaccination written on the card) 
• OPV3 immunization status 
• OPV3 Date (date of the OPV3 vaccination written on the card) 
• DTP3 immunization status 
• DTP3 Date (date of the DTP3 vaccination written on the card) 
• SIA (MCV) immunization status 
• SIA (MCV) Date (date of the SIA, written on the SIA card) 
• Adverse Events Following Immunization (AEFI) (high fever) 
• Adverse Events Following Immunization (AEFI) (vomiting) 
• Adverse Events Following Immunization (AEFI) (abscess) 
• Adverse Events Following Immunization (AEFI) (severe pain) 
• Adverse Events Following Immunization (AEFI) (rash) 
• Adverse Events Following Immunization (AEFI) (not immunized) 
• Adverse Event Following Immunization (AEFI) and reporting 
• Reasons for Failure to Immunize Y/N 
• Reasons for Failure to Immunize (type) 
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Annexe 3 List of derived variables 
 

The following derived variables (yellow cells) are calculated by excel on the basis of the original 
variables, and they do not need therefore to be entered and will be automatically generated 
during data entry. For specific details on each variable see the comment in each cell of the 
worksheet 

 

Order Fieldname Definition 

1 State_Cluster combination between geographical location of the child 
and the cluster number 

2 Year extracted from the date of birth 

3 Identified as card holder identifies those children who had an immunization card 

4 Card holder reviewed  identifies those children having cards with any dates on it 

5 SIA Card holder identifies those children who had an immunization card 
for SIA immunization. 

6 Vitamin A assumption of Vit A 

7 Days BCG 

it calculates the number of days since the birth when 
BCG immunization was administered. It is used for the 
validation of the dose according to the current National 
Immunization Schedule of the country. 

8 BCG any 
if BCG immunization by either history or card was 
reported. 

9 BCG No if No BCG immunization was reported. 

10 BCG by card if BCG immunization by card was reported 

11 BCG by history if BCG immunization by history was reported. 

12 BCG boys 
it identifies the boys among those children with BCG 
immunization 

13 OPV1 any 
if OPV1 immunization by either history or card was 
reported. 

14 OPV1 No if No OPV1 immunization was reported. 

15 OPV1 by card 
If OPV1 immunization by card was reported  

16 OPV1 by history if OPV1 immunization by history was reported. 

17 OPV1 boys 
it identifies boys among those children with OPV1 
immunization. 

18 DTP1 days since birth 
it calculates the number of days since the birth when 
DTP1 immunization was administered. It is used for the 
validation of the dose according to the current National 
Immunization Schedule of the country.. 

19 DTP1 valid 
it identifies valid doses of DTP1(the dose in considered 
as valid if administered after 42 days of age) 
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20 DTP1 invalid (only those vaccinated) 
it identifies invalid doses of DTP1 among immunized 
children 

22 DTP1 any 
if DTP1 immunization by either history or card was 
reported. 

23 DTP1 No if NO DTP1 immunization was reported. 

24 DTP1 by card 
if DTP1 immunization by card was reported 

25 DTP1 by history if DTP1 immunization by history was reported. 

26 DTP1 boys 
it identifies boys among those children with DTP1 
immunization. 

27 MCV any 
if MCV immunization by either history or card was 
reported. 

28 MCV No if NO MCV immunization was reported. 

29 MCV by card 
if MCV immunization by card was reported. 

30 MCV by history if MCV immunization by history was reported. 

31 MCV boys 
it identifies boys among those children with MCV 
immunization. 

32 MCV days since birth (card only) 
it calculates the number of days since the birth when 
MCV immunization was administered. It is used for the 
validation of the dose according to the current National 
Immunization Schedule of the country. 

33 MCV valid (card only) 
it identifies valid doses of MCV, according to the 
immunization date in the immunization card. Valid dose 
means a dose of MCV administered after 240 days of 
age 

34 MCV invalid (only those vaccinated 
it identifies invalid doses among those children received 
MCV immunization 

35 OPV2 any 
if OPV2 immunization by either history or card was 
reported. 

36 OPV2 card 
if OPV2 immunization by card was reported 

37 DTP2 any 
if DTP2 immunization by either history or card was 
reported. 

38 DTP2 card 
if DTP2 by card was reported 

39 OPV3 any 
if OPV3 immunization by either history or card was 
reported 

40 OPV3 No 
if NO OPV3 immunization was reported. 

41 OPV3 by card 
if OPV3 immunization by card was reported  

42 OPV3 by history if OPV3 immunization by history was reported. 
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43 OPV3 boys 
it identifies boys among those children who received 
OPV3 immunization. 

44 Days DTP1-DTP3 
it calculates the number of days between DTP1 and 
DTP3 immunization according to immunization dates 
written on the immunization card 

45 DTP days since birth 
it calculates the age of the child when the DTP3 
immunization was administered 

46 DTP3 valid 
it defines as valid a dose of DTP3 according to the age 
when it was administered. Valid is a dose which was 
administered after 56 days of age. 

47 DTP3 invalid 
it defines as invalid a dose of DTP3 according to the age 
when it was administered. Invalid is a dose which was 
administered before 56 days of age. 

48 
DTP3 any 

if DTP3 immunization by either history or card was 
reported. 

49 DTP3 No if NO DTP3 immunization was reported. 

50 DTP3 by card 
if DTP3 immunization by card was reported 

51 DTP3 by history if DTP3 immunization by history was reported.  

52 DTP3 boys 
it identifies boys among those children who received 
DTP3 immunization. 

53 Numerator DTP1-DTP3 drop-out 
calculates the numerator for DTP1-DTP3 drop-out 
calculation. Number of children who have received DTP1 
but not DTP3 by either card or history 

54 SIA (MCV) No if NO SIA (MVC) immunization was reported. 

55 SIA (MCV ) by card 
if SIA (MCV) immunization by card was reported  

56 SIA (MCV) by history if SIA (MCV) immunization by history was reported. 

57 Identified by interviewer as fully 
immunized 

it identifies those children who were fully immunized 
according to interviewer (who had no reasons for failure 
to immunize) 

58 Boys It identifies the boys among children in the sample 

59 Boys fully immunized (according to 
interviewer) 

it identifies boys fully immunized according to the 
interviewer 

60 Fully immunized with valid doses only 
(according to interviewer) 

It identifies fully immunized children with valid doses 
according to the interviewer 

61 Fully immunized by card it identifies fully immunized children with immunization 
card 

62 Fully immunized any (history and/or 
card) 

it identifies fully immunized children either by history or 
by card 

63 Interviewer failed to identify missing 
immunization 

it identifies those children for whom a reason for failure 
to immunize was reported and who were not fully 
immunized 
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64 Fully immunized by 1 year of age 
it identifies children who were fully immunized by 1 year 
of age 

65 Fully immunized by 1 year of age with 
valid doses 

it identifies children who were fully immunised by 1 year 
of age and received valid doses 

66 Adverse events (any) 
it identifies those children who had any adverse events 
following immunization 

67 No adverse events it identifies those children who had NO adverse events 

68 Adverse events reported 
it identifies those children who had adverse events which 
were reported to the AEFI surveillance 

69 Adverse events not reported it identifies those children who had adverse events which 
were NOT reported to the surveillance system 

70 Unaware of need for immunization it identifies those children for whom this was the reason 
for failure 

71 Unaware to return for 2nd and 3rd dose it identifies those children for whom this was the reason 
for failure 

72 Place/time immunization not known 
it identifies those children for whom this was the reason 
for failure 

73 Fear of side reaction 
it identifies those children for whom this was the reason 
for failure 

74 Wrong ideas about contraindications 
it identifies those children for whom this was the reason 
for failure 

75 Postponed 
it identifies those children for whom this was the reason 
for failure 

76 No trust in immunization 
it identifies those children for whom this was the reason 
for failure 

77 Rumours 
it identifies those children for whom this was the reason 
for failure 

78 Place of immunization too far 
it identifies those children for whom this was the reason 
for failure 

79 Time of immunization inconvenient 
it identifies those children for whom this was the reason 
for failure 

80 Vaccinator absent 
it identifies those children for whom this was the reason 
for failure 

81 Vaccine not available 
it identifies those children for whom this was the reason 
for failure 

82 Mother too busy 
it identifies those children for whom this was the reason 
for failure 

83 Family problems 
it identifies those children for whom this was the reason 
for failure 

84 Child ill, not brought 
it identifies those children for whom this was the reason 
for failure 
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85 Child ill, not immunized 
it identifies those children for whom this was the reason 
for failure 

86 Child ill 
it identifies those children for whom this was the reason 
for failure 

87 Long waiting time 
it identifies those children for whom this was the reason 
for failure 

88 On trip obstacles 
it identifies those children for whom this was the reason 
for failure 

89 Did not know date of campaign 
it identifies those children for whom this was the reason 
for failure 

90 Not free at the time 
it identifies those children for whom this was the reason 
for failure 

91 Religious reasons 
it identifies those children for whom this was the reason 
for failure 

92 Lack of information (general) 
it identifies those children for whom this was the reason 
for failure 

93 Forgot the child's age 
it identifies those children for whom this was the reason 
for failure 
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